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Prez Says: Ron Cowger 
As I write this column it is not yet the end of January but I have to get the column finished 
today as my wife and I are leaving for a short trip from which we will not return until early 
February.  Therefore, I hope that you will understand if I don’t have all of the latest infor-
mation as the January meeting of the Board has not yet taken place.  Anyway, let’s review 
some of the recent group happenings. 
 
I hope that each of you was able to attend the special General Meeting that we held in 
January at the new Microsoft Store in Bellevue Square.  Everyone that I talked to after the 
event enjoyed the tour of the store and viewing some of the “gee whiz” gadgets that they 
have in the store and for sale.  I was sufficiently impressed with one of the small laptops 
that I bought it.  I received several comments from members who felt that the meeting 
space in the store’s theater was rather small for a group our size.  Also, some folks felt that 
the crowd noise from the customers and the employees traveling back and forth through 
the room were rather distracting.  Lastly, some members felt that the bench-style seats 
were rather uncomfortable for a two-hour long meeting.  At the meeting of our Board, the 
members will discuss using the theater at the store for future KEGS meetings.  If you have 
further inputs on this subject, please forward them to one of our Board members as soon as 
you can.  The current plan under discussion is to have a couple of General Meetings there 
per year when their staff has some new piece of software or hardware that they want to 
demonstrate to us. 
 
I want to apologize to some of our members who loaded up the door prize bucket with lots 
of extra tickets in anticipation of a drawing for a great Microsoft product.  I did not know 
until the end of the meeting that each of the attendees would be receiving the same bag of 
“favors.”  Anyway, I hope that there was something in your bag that you found to be use-
ful. 
 
The February presentation will be from Steve Fondren.  As many of you know, 
Steve has been trying to get through a list of some of his favorite applications and 
tools that he uses to troubleshoot and repair computers.  Due to many questions 
and sometimes getting off track during his SIG that precedes the General Meet-
ing, Steve has not gotten very far into his list.  Therefore, Steve has graciously 
agreed to be the main presentation speaker at the General Meeting to ensure that 
he has time to get all the way through his topic.  I’m looking forward to his presen-
tation as I know he has developed the collection of tools based on working as ef-
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fectively and efficiently on problems that he encounters during customers’ ser-
vice calls.  This information should be very helpful to most of us.  I hope to see 
each of you there. 
 
The changes to the alignments of three SIGs that I wrote about last month were imple-
mented in January and seem to be going well.  If you attend one or more of the affected 
SIGs and you have comments about the changes, please let the SIG leader(s) know.  We 
are always open to new ideas and other inputs. 
 
We are still preparing the order for our new KEGS vests.  Joe is continuing to work on 
the logo PDF file that we must provide to our supplier.  I don’t yet know when the vests 
will arrive but will let you know as soon as we have a target date.  The Board has de-
cided to order twelve of the vests in grey as there seems to be enough interest in that 
color to justify satisfying the demand. 
 
This month there are two new tips from Sharon Parq Associates added to our monthly 
newsletter.  There is one for using Word and the other for Excel, each designed to ex-
pand our knowledge of these applications.  If you want access to additional tips from 
this company, you can go to their websites at word.tips.net or excel.tips.net.  I think 
you’ll find the information interesting and useful. 
 
The most recent figures from John Tate indicate that 40 members have renewed their 
membership for 2011.  I hope that those of you that didn’t get around to renewing yet 
will do so as soon as possible.  Renewal forms are available from John Tate, our Treas-
urer, or you can fill out the form on the KEGS web site, print it out and send it along 
with your check to the address shown on the form.  An even easier way would be to 
bring your completed form and your check/cash to the next General Meeting and give it 
to John there. 
 
That’s it for now.  I hope to see each of you at the General Meeting or at your favorite 
SIG.  I wish you happy and safe computing! 

Ron Cowger 
President 



Automatically Selecting Words 
When you are editing your document, there are many times that Word tries to guess what you are 
doing and then complete your task for you. This helpfulness can be aggravating at times. One such 
instance is when you are trying to use the mouse to select text from the middle of one word to the 
middle of another. Whenever you click inside a word and then start dragging the mouse, Word as-
sumes you want to make a selection. As soon as you move the mouse pointer outside the word, the 
program assumes you wanted to select the entire first word in which you originally clicked. 

If you want to ensure that Word doesn’t make that assumption, you need to follow these steps to turn 
off the offending feature in Word 97 through Word 2003: 

1. Choose Options from the Tools menu. Word displays the Options dialog box. 
2. Make sure the Edit tab is selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Edit tab of the Options dialog box. 
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Word Tip of the Month 



3. Make sure the When Selecting, Automatically Select Entire Word check box is cleared. 
4. Click on OK. 

You can follow these steps if you are using Word 2007 or Word 2010: 

1. Display the Word Options dialog box. (In Word 2007 click the Office button, then choose 
Word Options. In Word 2010 display the File tab of the ribbon, then click Options.) 

2. Click Advanced at the left side of the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Advanced area of the Word Options dialog box. 

3. In the Editing Options area, make sure the When Selecting, Automatically Select Entire 
Word check box is cleared. 

4. Click on OK. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word 
tips can be found online at http://word.tips.net. 
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Calculating Week-Ending Dates 
Do you keep track of information based on week-ending dates? Many businesses do, and there-
fore need a quick way to calculate the week-ending dates for the complete year. The dates could 
be easily calculated with a macro, but you can do it just as easily with formulas. 

There are two formulas you can use in order to calculate your week-ending dates. Let’s assume, 
for the sake of this example, that your year is stored in cell A1. You could then figure out the 
first Saturday of the year by using this formula in cell A3: 

This works because the WEEKDAY function returns a value of 1 (Sunday) through 7 (Saturday) 
for any date. If you subtract that value from 7, then you have a value of 6 (Sunday) through 0 
(Saturday). When you add that value to the DATE value for January 1 of the year, you end up 
with the first Saturday of the year. 

If you prefer to have your weeks end on Fridays, then the formula needs to change a bit: 

Finally, if you prefer to have your weeks end on Sundays, then the formula needs to be like this 
one: 

This formula uses a parameter for the WEEKDAY function that calculates weekdays that range 
from 1 (Monday) through 7 (Sunday). 

Once you have the first week-ending date for the year (in A3, remember?), then you can calcu-
late the rest of the week-ending dates for the year. Place the following formula in cell A4: 

 

=IF(YEAR(A3+7)=$A$1,A3+7,"") 

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1),2) 

=DATE(A1,1,1)+7-(WEEKDAY(DATE(A1,1,1)+1)) 

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1)) 
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This checks to see if one week past the previous date is still in the year. If it is, then the new date 
is returned. If it isn’t, then an empty string is returned. If you copy this formula from A4 down 
through A55, then you will have all the desired week-ending dates for the year. With the formu-
las in place, simply change the year in cell A1 to see how the dates change. 

The range A3:A55 provides room for 53 week-ending dates, which is possible for any given 
year. Because you used the IF statement in the formula in cells A4:A55, then the very last value 
(A55) will be blank if there were only 52 week-ending dates for the year. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft 
Excel tips can be found online at http://excel.tips.net. 
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KEGS General 
Meeting 
And Associated SIGs 

KEGS T-shirts 
Remember, you score extra KEGABUCK$ 
when you wear your KEGS shirts to SIGS 
and the General Meetings!  (NOTE: This 
extra credit is not honored at the PIG SIG.) 

We still have a few left of various sizes.  
Then we will order more.  So why wait?  
Pick yours up at the next general meeting. 

Day of Month Time Location  SIG / Email contact  SIG Leader 

2nd Monday 6 PM - 7 PM Kirkland Teen Union 
Building 

Technology Corner 
   betacode@hotmail.com 

Steve Fondren 

2nd Monday 7 PM - 9 PM Kirkland Teen Union 
Building 

KEGS General Meeting  

2nd Monday 9:30 PM - ? 
PM 

Outback Steakhouse 
12120 NE 85 th, Kirkland 

Pig SIG 
   sallyannmowrey@msn.com 

Sally Ann Mowrey 
206-996-5635 

General Meetings at the Kirkland Teen Union Building - 348 Kirkland Ave., Kirkland, WA 98033 

DRIVING INSTRUCTIONS: From I-405, take the N.E. 85th ST. exit (exit number 18) toward KIRK-
LAND (headed West).  Immediately move to the center lane and take a left at the first light onto 
Kirkland Way (If you went right you would be on 114th Ave NE).  Just stay on Kirkland Way and it 
will turn into Kirkland Ave.  

The Kirkland Teen Union Building is part of a string of connected buildings.  Right at the street is 
Kirkland's Performing Arts Center, then comes the Kirkland Senior Center and farthest from the 
street is The Kirkland Teen Union Building. 

There is a parking area to the West of this building but you can also park in the Kirkland Library's 
covered parking area just a little farther to the West ( 1/4 block past the Performing Arts Center). 

mailto:betacode@hotmail.com�
mailto:sallyannmowrey@msn.com�


KEGS SIG Meetings: 
KEGS T-shirts 
Remember, you score extra 
KEGABUCK$ when you wear 
your KEGS shirts to SIGS and the 
General Meetings!  We still have 
a few left of various sizes.  
Then we will order more.  So 
why wait?  Pick yours up at the 
next meeting. 

NEW SIG CHART 
Notice that this SIG chart  no longer lists actual dates.  Please check our KEGS calendar (at 
http://www.kegs.org/Calendar.html) for actual dates AND POSSIBLE CANCELLATIONS of 
the upcoming meeting that you want to attend. 

Contact the SIG leaders to find out what presentations that they have planned for their up-
coming meetings. 

Meetings at the North Bellevue Community / Senior Center - 4063  148th Ave NE, Bellevue, WA  

Day of Month Time Location  SIG / Email contact  SIG Leader 

1st Wednesday 7 PM - 9 PM Conf. room D Seattle Internet User Group 
   seasigi@kegs.org 

Marianne Wilkins 

2nd Tuesday 7 PM - 9 PM Computer Lab Computer Support SIG - N. Bellevue 
   j_m_mraz@hotmail.com 
(Computer repair & maintenance) 

Joe Mraz 
425-747-2433 

2nd Wednesday 7 PM - 9 PM Conf. room D Computer Use and Optimization 
   ctheprof@aol.com 

Carl Von Papp 
425-643-1398 

3rd Tuesday 7 PM - 9 PM Conf. room D Servers. Networks and Storage 
   daviddodge1@compuserve.com 

David Dodge 

3rd Wednesday 7 PM - 9 PM Conf. room D Small Office / Home Office (SOHO) 
   r_cowger@prodigy.net 

Ron Cowger 

4th Tuesday 7 PM - 9 PM Conf. room D Digital Imaging SIG 
   sallyannmowrey@msn.com 

Sally Ann Mowrey 
206-996-5635 

4th Wednesday 7 PM - 9 PM Conf. room D HTML SIG 
   jackbewitch@comcast.net 

Jack Beslanwich 
206-723-9960 

2nd Tuesday 7 PM - 9 PM Conf. room D Digital Video SIG 
   jackbewitch@comcast.net 

Jack Beslanwich 
206-723-9960 

     

http://www.kegs.org/Calendar.html�
mailto:jackbewitch@comcast.net�
mailto:seasigi@kegs.org�
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Please note that the KEGS Board meetings are not held at our General Meeting or SIG  
meeting locations 
• KEGS Board Meetings are currently held at Executive Real Estate’s Bellevue office at 20 

Lake Bellevue, Bellevue, WA.  (Board meetings are public and open to anyone who wants 
to attend.) 

SIG Meeting Locations: 

Finding our primary SIG meeting location 
 

DRIVING INSTRUCTIONS: Thanks to the improvements to SR 520, you may now use the new 
NE 40th St exit. If you are driving towards Redmond, exit and turn left to go over the over-
pass. If you are coming from Redmond, exit and turn right. Go to 148th Ave NE, and turn 

right. In very short order, you will see the North Bellevue Community / Senior Center sign on 
the left side of the roadway. 

KEGS was formed in late 1996 to meet the needs of personal computer users in the Greater 
Seattle Area. KEGS is a nonprofit organization that holds its general meetings on the second 
Monday of each month.  
In addition, KEGS sponsors a number of special interest groups (SIGs) that meet regularly 
to share common interests, learn new techniques, and resolve questions about the use of per-
sonal computer hardware, accessories, or software. 

History & Contact info: 

For a detailed listing of our SIG’s, up-
dated information about KEGS activities, 
and more, please see our web site at:  
 
              http://www.kegs.org. 

 Contact us at: Email: info@kegs.org 
 The Komputer Enthusiasts of Greater Seattle  
 PMB# 195  
 677 120th Ave NE, Suite 2A  
 Bellevue, WA 98005     
 Or call 425-747-2433 before 9 PM 

To submit articles or software reviews for incorporation into this Newsletter, please send them 
to:   newsletter@kegs.org 
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